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•	 All rights reserved, including those to reproduce this manual or parts 
thereof in any form without permission from Shimadzu Corporation. 

•	 The information in this manual is subject to change without notice and does 
not represent a commitment on the part of the vendor.

•	 Any errors or omissions which may have occurred in this manual despite 
the utmost care taken in its production will be corrected as soon as 
possible, although not necessarily immediately after detection.

•	 Maintenance parts for this product are provided for seven years after 
production has stopped. Please note that we may not be able to provide 
maintenance parts after this period. However, for parts that are not genuine 
Shimadzu parts, the period of provision is determined by the manufacturer.

•	 The contents of the hard disk in a PC can be lost due to an accident. 
Backup your hard disk to protect your important data from accidents.

•	 If the user or usage location changes, ensure that this Instruction Manual is 
always kept together with the product.

•	 Original version is approved in English.

©2010-2019 Shimadzu Corporation. All rights reserved.

NOTICES
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Types of Manuals
Five Instruction Manuals are provided with LabSolutions.
You can also display the [Help] menu to confirm the meanings 
and setting ranges of parameters. 
The following shows how to make full use of the manuals.

��Getting Started Guide
This manual is for first-time users.
Follow the sequence of procedures in this guide to gain 
an understanding of basic LabSolutions operations.

��Operators Guide
This manual gives comprehensive 
information about overall 
data acquisition operations in 
LabSolutions, such as system 
configuration, data analysis, batch 
processing, and report functions.

��System Users Guide
This manual is for system 
administrators. 
This manual describes system 
administration and data 
management.

��Data Acquisition & 
Processing Theory Guide
This manual describes peak 
detection and quantitation of sample 
components (for advanced users).

�� Installation & 
Maintenance Guide
This manual describes installation 
and maintenance of the LabSolutions 
software.

��Help
Refer to [Help] to learn more about 
the displayed sub-window. 
Click the on-screen [Help] button 
or the [F1] key on the keyboard to 
display [Help]. 

The meanings of symbols used in this manual are 
as follows.

b
Useful advice for convenient 
instrument operation

B
Shows where to refer to in the 
Operators Guide
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What LabSolutions Can Do
LabSolutions software is very easy to use, while incorporating high-grade functions.
It provides powerful support for automating and improving the efficiency of sequential 
data acquisition and analysis operations.
Use LabSolutions to perform the following functions.

•	 Control of analytical instruments and data acquisition
•	 Data analysis and viewing of data
•	 Creation and printing of various customizable reports
•	 Data management

System Structure
This Getting Started Guide describes data acquisition operations with the assumption 
that the system includes the following instruments.

•	 Detector SPD-40V •	 Autosampler SIL-40C

•	 Pump LC-40B XR •	 Column oven CTO-40C

LC-40B XR

SIL-40C

CBM-40Lite

SPD-40V

CTO-40C
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File Types

Data file (.lcd)

This file contains all analysis results and acquisition information from the following files.

Method file (.lcm)

Acquisition conditions,  
analysis conditions,  
calibration curve information,  
and etc.

Batch file (.lcb)

This file is used for
continuous data acquisition
of sequential samples.

Report format file (.lsr)

This file is used to print
data acquisition results.
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-Checks Before Operation-

Data Acquisition Flow
Set up the data acquisition conditions to 
suit the component to be measured.

Before starting data acquisition, set up the data acquisition conditions on 
LabSolutions.
For the data analysis operations described in this manual, set as follows:

Column
Shim-pack VP-ODS  
(150 mm L × 4.6 mm i.d. 5 μm)

Mobile phase Pump A = Water, Pump B = Acetonitrile

Flow rate (mobile phase) 1.0 mL/min

Column temperature 40 °C

Detection wavelength 254 nm

Sample Injection volume 10 μL

Sample
Mixtures of para hydroxy benzonic acid ester (paraben 
mixed sample) 10, 20 and 40 ppm standard samples, 
and 2 unknown samples

Set Up the 
Conditions 

STEP 1

When you have finished setting up the data acquisition 
conditions, 

start off by acquiring the data.

On LabSolutions, the operation of analysis samples one at a time is called 
"single run".

To evaluate the data acquisition conditions, change the data acquisition 
conditions, measure standard samples and unknown samples, and check 
the separation state of the target component. 

Perform data acquisition on other samples using the data acquisition 
conditions that provided the optimum separation state. 

B 3 Single Run P.23

Data 
Acquisition

STEP 2
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Setting up the data acquisition conditions and 
optimizing the data processing parameters are 
important for obtaining better data acquisition results. 
This section describes the basic flow of data analysis.

Perform data acquisition on sequential 
samples together. 
Realtime batch is performed to measure sequential samples continuously 
when the data acquisition conditions have been fixed by performing a 
single run.

B 5 Realtime Batch P.31

B 6 Multiple Data Analysis P.40

Realtime 
Batch

STEP 4

Display the data files acquired using 
realtime batch in step 4 by specifying 
filtering conditions in the Data Manager.
The Data Manager can display PDF files created during data acquisition.

B 7 Data Management P.48

Data 
Management

STEP 5

Process the acquired data, and 
apply the analysis conditions.
Normally, multiple data is analyzed to determine peak integration 
conditions so that consistent results (e.g. repeatability of retention time 
and peak area, detection limits of target components, and linearity) can be 
acquired.

When the data analysis conditions have been fixed, quantitative calculation 
(i.e. investigation as to how much of the target component is contained 
in the sample) is performed on the unknown sample based on the data 
analysis results of the acquired standard sample.

To perform quantitation, a calibration curve must be made from the known 
concentrations and peak area values of the standard samples. This 
calibration curve is used to calculate the concentration of the unknown 
sample.

B 4 Data Analysis P.25

STEP 3
Analysis
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LabSolutions Main Window

[Data Acquisition] 
window

for acquiring data

[Realtime Batch] 
window

for realtime batch
processing

[Data Analysis] 
window

for analyzing data

[Quant Browser] 
window

for analyzing data
from multiple

samples

 LabSolutions Main Programs and Main Windows

[Realtime Analysis]  
program

[Browser] 
program

[Postrun Analysis] 
program

[Instruments]
The analytical instruments connected to the PC are displayed 
as icons.

Double-click  to start the [Realtime Analysis] program 

where data acquisition settings are set and data is acquired.

[Postrun]
Displays the icons for the [Postrun Analysis] program (data 
analysis), and the [Browser] program 
(chromatogram display and quantitative calculation of 
results).

[Manual]
Displays the icons for the various PDF manuals and Help 
menu provided with LabSolutions.

[Administration]
Displays the icons of the system administration programs 
for data management, setting security policies, user 
administration and the log browser.

[Project]
Displays the currently open project. Projects comprise instruments, 
users, data, and other relevant information. 

Click  to open the project selection window.
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 LabSolutions Windows

The following example describes the 
[Realtime Analysis] program window.

Title Bar
This bar displays the names of the current program, window, project, loaded file, and other information.

Menu Bar
This bar displays the current window and menus that are available based on the operating rights of the current user.

Toolbar
This bar displays icons of frequently used menu items and icons for operating analytical instruments.

1

Assistant Bar
This bar displays 
icons for 
frequently used 
data acquisition 
operations.

Data Explorer
This sub-window 
displays files 
for the selected 
project and 
instruments.

2
Window
In the [Realtime Analysis] program, [Data Acquisition], [Realtime Batch] 
and other windows are displayed as icons on the assistant bar.
In the [Postrun Analysis] program, [Data Analysis], [PDA Data Analysis], 
[Calibration Curve], [Report Format] and other windows are displayed. 
Switch the windows by clicking the icons on the assistant bar. 
Instrument Monitor (right side of the window) check the acquisition 
conditions and connections.

3

Output Window
This window displays an operation history and error messages that occur.

4

2

1

3

4
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B 1 Start Up P.12

 How to Open Windows
Note that a project must be selected in order to open windows.

1 2

3

Set the Data Acquisition Parameters and Execute a Single Run:
Open the [Data Acquisition] window from the main window.

▲Main Window

▼[Data Acquisition] window

B 2 Set the Instrument Parameters P.18

B 3 Single Run P.23

▼[Realtime Analysis] program

1 2

3

Continuous Data Acquisition of Sequential Samples:
Open the [Realtime Batch] window from the main window.

▲Main Window

▼[Realtime Analysis] program

B 5 Realtime Batch P.31

▼[Realtime Batch] window
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2

1
5

pMain Window

B 4 Data Analysis P.25

Data Analysis and Quantitative Calculations:
Open the [Data Analysis] window from the main window.

q[Postrun Analysis] program

[Data Analysis] windowu

Double
Click !

3

4

2

1

pMain Window

Double
Click !

3

4

q[Browser] program

Multiple Data Analysis and Quantitative Calculations:
Open the [Quant Browser] window from the main window.

B 6 Multiple Data Analysis P.40

[Quant Browser] windowu

5
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1	Check the connections.
Ensure that all of the units (pump, autosampler, column oven, and detector) of the 
analytical instruments are connected to the system controller and optical link cables.

2	 Turn the power on for each of the instruments.

LC-40B XR

SIL-40C

CBM-40Lite

SPD-40V

CTO-40C

3	 Turn the PC and printer on.

4	Double-click  on the desktop.
The [Login] sub-window opens.

Start Up
This chapter describes how to start up LabSolutions.

$$ �Refer to "LC Data Acquisition" in Operators Guide for details on the "Data Acquisition" window.

Chapter

1



13

1  Start Up

5	 Log in.

2

Enter "Admin".
1

6	 Select a project.
Upon initial startup, the project selection window is displayed after logging in. In this 
case, select the desired project. For subsequent startups, the [Realtime Analysis] pro-
gram opens using the project selected when the previous session was closed.

The [Select Project] window is 
also displayed when logging in 
for the first time using a newly 
created user.

DD �

1

2

$$ �Refer to "System Management" in the Operators Guide for details on creating users.

7	Open the [Realtime Analysis] program.

1 2

Continued on the following page
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8	Open the [Data Acquisition] window.

DD �Click here if the [Main] assistant bar 
is not displayed.

9	Confirm the status.

In a normal state, [Ready] is displayed for the status.
Follow the recommendations below if [Not Connected] 
is displayed.
•	 Ensure that the power is ON.
•	 Ensure that instruments are connected correctly.
•	 Ensure that the system configuration settings are 

correct.

B  [Re-Set the System Configuration] P.15 for 
details.



15

1  Start Up

LabSolutions

SUPPLEMENT
"I want to connect to the system."
"I want to change the system configuration."

In such cases

Re-Set the System Configuration.

1	Open the [System Configuration] sub-window.

DD �Click here if the [Main] assistant bar is not 
displayed.

The [System Configuration] sub-window opens.
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2	Open the [Data Acquisition] window.

1

2 3

The [Instrument] sub-window opens.

Select the system 
controller to use. Click 

4

5

Select [RS-232C] or [Ethernet]. 
For an [Ethernet] connection, enter 
[IP Address].

Click here to display each instrument 
currently connected to the system controller 
at [Modules Used for Analysis] in the 
[System Configuration] sub-window.

When using a photodiode array (PDA) detector, 
select the desired detector in the [Model] list 
on the [PDA] row, and select [SCSI Port] or [IP 
Address] at [Communication Settings].

DD �

3	Check that the system configuration is correct.

1

Double-click the unit, 
and set the properties 
of each unit. 

2

Click here to send the settings to the LC.
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1  Start Up

LabSolutions

SUPPLEMENT "I want to change to another project."
In such cases

Click [Select Project].

2

3

Click [OK] to change to the selected 
project. The name of the selected project is 
displayed.

Select the desired project.

1
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1	Open the [Data Acquisition] window.

2	 Set each of the parameters on the [Simple Settings]  
	 tab.

5

4

2

6

1

3

Mode	 :	 Binary gradient 
T.Flow	 :	 1.0000 mL/min 
B.Conc	:	 45 %

Set [Oven] to .
Temperature : 40 °C

Set [Detector A] to . 
Wavelength Ch1	:	 254 nm 
End Time	 :	 10.00 min

LC Stop Time : 10.00 min

$$ �Refer to P.6 for details on data acquisition conditions.

$$ �Refer to "Set the Instrument Parameters" of the "LC Data Acquisition" chapter in the Operators Guide for 
details on instrument parameters.

Set the Instrument Parameters
The data acquisition method (instrument parameters) are saved to the method file after 
they have been set in [Instrument Parameters View] in the [Data Acquisition] window.
This chapter explains how to set the instrument parameters.

Chapter

2
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2  Set the Instrument Parameters

3	 Save the data acquisition conditions.

4

Click here to download the 
data acquisition conditions 
to the instrument.

1

2

Enter "Tutorial_Method".

3

LabSolutions

SUPPLEMENT Retrieve a method from the 
database using the Data Explorer 
and perform analysis.

1

2

Select the method 
icon.

3

4

Select a method.

Right-click on the Data Explorer and 
select [Get the file from database].

Click on the "Display Data Explorer" icon 
if the Data Explorer is hidden.DD �

5
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LabSolutions

SUPPLEMENT Control Panel
Using the control panel, you can edit data acquisition conditions (instrument 
parameters), check instrument status, and control the instrument. This section 
describes how to set instrument parameters using the control panel.

This part is called control panel. The 
instrument status can be checked.

1

2

3
Click here to download the data acquisition conditions 
to the instrument and to close this sub-window.

Set data acquisition conditions 
(instrument parameters).

Switching Display Settings
In the [Display Settings of Instrument Parameter View] sub-window, you can select displaying either the 
control panel or the instrument parameter view.

DD �

1

2

3
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2  Set the Instrument Parameters

LabSolutions

SUPPLEMENT Baseline Check
By the baseline check, you can check whether or not noise and drift values on the 
baseline are within the preset time and at the threshold or below. 
Baseline check parameters are saved in the method file.

1	 Set [Baseline Check Parameters].

1

3
2

4

Set both [Noise] and [Drift] to  , and enter 
[Start], [End] and [Threshold].

In the [Baseline Check] sub-window, the noise calculation method can be changed, and the maximum 

delay time when the result of the baseline check is [Fail] within the preset time. B  Help for details.
DD �

2	 Perform the baseline check.

1

After measurement ends, the check results are displayed in Baseline Check Results sub-window and 
Output Window.

Output Window

Baseline Check Results
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LabSolutions

SUPPLEMENT Slope Test
By performing the Slope Test, the peak detection sensitivity (Slope value) of peak 
integration parameters can be automatically set from the status of the noise and 
drift appearing on the chromatogram before data acquisition. 
This section describes the Slope Test.

•	 Slope values refer to the numerical values for determining the peak start and end points.  
To be more precise, the peak start point is judged when a ascent slope exceeds the preset 
value, and, alternatively, the peak end point is judged when a descent slope falls below 
the preset value.

•	 Optimum Slope values can be obtained from the data by the Slope Test. 

DD �

Right-click on [Chromatogram View] 
and select [Slope Test].

The measurement result is 
displayed when the test ends. To apply the measurement result to the 

peak integration parameters, click here.

To make preset values clearer, set a value rounded up to 
the nearest integer larger than the displayed slope value.
For example, set "1000" for "986.36".  

DD �
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3  Single Run

1	Open the [Data Acquisition] window.

2	Open the [Single Run] sub-window.

The [Single Run] sub-window opens.

Single Run
This chapter describes the operation of measuring a standard sample once only (single 
run) using a saved method file "Tutorial_Method.lcm".
First, perform single run using a standard sample.

Chapter

3
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3	 Set the conditions for a single run.
In this example, set the conditions for pouring 10 ppm of paraben mixed sample into 
vial No.1 on the autosampler, and injecting 10 μL of that sample.

DD �Click here to cancel data 
acquisition midway.

DD �Data acquisition automatically ends 
when the [LC Stop Time] set in the 
method file is exceeded.

1

3

2

Enter "Test".

Vial#	 :	1 
Injection Volume	:	10 µL 
Tray	 :	1

Click here to start the 
acquisition.

The status changes to  
when data acquisition ends.
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4  Data Analysis

1	Open the [Postrun Analysis] program.

1

2

Double
Click !

3

4

Select the instrument.

2	Open the [Data Analysis] window.
DD �Click here if the [Main] assistant bar is not 

displayed.

The [Data Analysis] window opens.

Data Analysis
After single run ends, check the data to see if the peaks have been detected correctly.
This chapter describes how to change the peak integration conditions of the data 
file "Test.lcd" obtained by performing single run to optimize the peak integration 
parameters.

Chapter

4



26

3	Display "Test.lcd".

Click  on the upper section of the Data 
Explorer and then double-click "Test.lcd".

$$ �Refer to "Data Analysis" chapter in Operators Guide for details on the "Data Analysis" window.

Continued on the following page
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4  Data Analysis

4	 Enter the peak integration parameters.

Width values refer to the minimum half-width value (height 1/2 width) of the peak to detect. 
Noise peaks are removed by optimizing the Width value. 
Determine the start and end points of the peak by the Slope value. 
The positions where the absolute values of the baseline slope become these values are the start and end 
points of the peak.

$$ �Refer to "Peak Integration Parameters" of the "Data Analysis" chapter in Operators Guide for 
details on the Peak Integration Parameters.

DD �

5 1

4
Width : 5 sec

Slope : 1000 uV/min

2

3

Click  to edit each 
parameter value.
Click  to perform 
processing on the data, and the 
processing results are displayed 
in [Chromatogram View] and 
[Results View - Peak Table].
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5	 Enter the quantitative parameters.

DD �Click  to enlarge the 
window.

3

2

4

5

1

ZOOM 
UP

Quantitative Method : External Standard

X Axis of Calib. Curve : Conc.

•	 The [External Standard] method involves calculating concentrations from 
the peak area (height) of unknown samples using a calibration curve 
made based on a standard sample.

•	 At [# of Calib. Levels], set the number of concentration points for the 
standard sample required for creating the calibration curve.

•	 When creating calibration curves with the least squares method, set 
[X Axis of Calib. Curve] to [Conc.].

DD �

# of Calib. Levels : 3

Continued on the following page
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4  Data Analysis

6	 Fill in the Compound Table.

Name Type Ret. Time Conc.(1) Conc.(2) Conc.(3)

Methylparaben Target 3.046 10.000 20.000 40.000

Ethylparaben Target 3.924 10.000 20.000 40.000

Propylparaben Target 5.505 10.000 20.000 40.000

Butylparaben Target 8.267 10.000 20.000 40.000

•	 The result obtained by performing data acquisition is used for [Ret. Time]. 
•	 Selecting the [Ret. Time] cell, and clicking the peak in [Chromatogram View] automatically 

enters the retention time of that peak to the currently selected [Ret. Time] cell.	  
The retention time can be set by simply clicking the mouse.

DD �

ZOOM 
UP

3

Click  to 
change the cell 
background color to 
yellow to fix the newly 
edited parameters.

2
1

$$ �Refer to "Compound Table Retention Times Using the Mouse" of the "Data Analysis" chapter in the 
Operators Guide for details on setting retention times.
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7	 Save the processing results to a data file.

Click here to save the processing results 
to "test.lcd".

8	 Save the method file.

1

Click here to open the [Save Method As] 
sub-window.

6

To use saved data processing parameters for other data, perform either of the following operations to save the 
new data processing parameters to the method file (in this example, "Tutorial_Method.lcm"). 

•	 Click [Save Data and Method File] on the [File] menu.

•	 Click  (Apply to Method) on the [Data Analysis] assistant bar (operation in step 8 above).

DD �

2

3

Select "Tutorial_Method" lcm.

4

5

Click here to save the new 
data processing parameters 
to "Tutorial_Method.lcm".

Set to 
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5  Realtime Batch

1	Open the [Realtime Analysis] program.

1
2

2	Open the [Realtime Batch] window.
DD �Click here if the [Main] assistant bar is not 

displayed.

The [Realtime Batch] window opens.

Realtime Batch
To perform data acquisition continuously on multiple samples (realtime batch), a Batch 
Table must first be created. Batch Tables can be easily created by using the table easy 
setting feature of LabSolutions.

Chapter

5
	5.1	 Create a Batch Table

In the following example, create a Batch Table with standard samples set to 1st to 9th 
rows, and unknown samples set to the 10th and 11th rows.
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3	 Edit the Batch Table.

1

•	 In Batch Tables, you can set the sample information of each sample and output of reports.

$$ �Refer to "Edit Batch Tables" of the "Realtime Batch" chapter, "Edit Batch Tables" of the 
"Calibration Curves" chapter in Operators Guide for details on the editing batch tables.

•	 Enter "-1" in [Vial#] to acquire data without injecting samples from the autosampler.

DD �

2

3

Set [Standard] to .
Vial#	 :	 1 to 3 
Injection Volume	 :	 10 µL
Repetitions	 :	 3 
Data File	 :	 Tutorial_Std

Click here to create a 
Batch Table made up 
of 11 rows.

Set [Unknown] to .
Vial#	 :	 4 to 5 
Injection Volume	 :	 10 µL 
Data File	 :	 Tutorial_Unk

4

5

Select [New].

Continued on the following page
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5  Realtime Batch

4	Copy a cell.

3

4

5

2

Select here.

1

5	 Enter a numbered series.

3

4

5

21

Select here.
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6	Directly enter remaining items to the Batch Table to  

	 create the Batch Table shown below.

7	 Save the batch file.

1

3
2

Enter "Tutorial_Batch".
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5  Realtime Batch

LabSolutions

SUPPLEMENT Create a Batch Table Using  
Quick Batch
You can also create a Batch Table using quick batch.

Enter the sample 
information.

Select a sample 
type and vials.

Start realtime batch.

2

4

1

5

3

Click here to add them to a Batch Table. With 
the settings shown in this figure, a Batch 
Table for the standard sample is created.
Also, for the unknown sample, perform the 
procedures (2) and (3) shown in this figure to 
add them to the Batch Table.

$$ �Refer to Help for details on operations and the applicable models.

When [(Auto Filename)] is displayed in the [Data File Name] field, you cannot directly enter a 
data file name. To enter a data file name directly, click [Settings] in the [Quick Batch] sub-window. 
On the [Data File Name] tab page in the displayed 
[Settings] sub-window, clear the [Create filenames 
automatically with] checkbox.

DD �
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	5.2	 Realtime Batch Processing
Execute realtime batch using the Batch Table you created.

1	 Place the samples in the autosampler.

Vial 1 (level 1) Paraben mixed sample 	 10 ppm solution (standard solution)

Vial 2 (level 2) Paraben mixed sample 	 20 ppm solution (standard solution)

Vial 3 (level 3) Paraben mixed sample 	 40 ppm solution (standard solution)

Vial 4 Unknown sample (to be quantitated)

Vial 5 Unknown sample (to be quantitated)

2	 Start realtime batch processing.

Click here to cancel data acquisition midway. 
To edit the content of the Batch Table during 
realtime batch, click  to pause realtime batch.

1 Click here to open the [Realtime Batch] and [Data 
Acquisition] windows simultaneously, and starts 
data acquisition from the 1st row of the Batch Table.
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5  Realtime Batch

LabSolutions

SUPPLEMENT

Print a Summary Report

1	 Add items to display in the Batch Table.

1

DD �The order of display items in the 
Batch Table can be changed by 
clicking [Up] or [Down].

3

4

2

Click here to add [Summary Type] and 
[Summary Report Format File] to the 
items to display in the Batch Table.

2	 Set up the summary report.

4

Select "SummaryReport_4".

5

After setting the summary report at Row Number: 1 
to 3, set Row Number: 4 to 6, 7 to 9, and 10 and 11 
in the same way.
Repeat step 2  onwards in the same order.

DD �

1

2

3

6

Row Number : 1 to 3

                                                               

Continued on the following page
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3	Check the output configuration of the summary report.

When you have finished the output configuration of the summary report, execute realtime batch to 
print the summary report.

$$ �Refer to "5.2 Realtime Batch Processing" P.36 for details on executing realtime batch.

 [Printout Example]
Standard samples
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5  Realtime Batch

Unknown samples
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1	Open the [Browser] program.

1

2

Double
Click !

3

4

Select the instrument.

2	Open the [Quant Browser] window.

Open the [Quant Browser] window.

Multiple Data Analysis
The LabSolutions [Browser] program is handy for checking the quantitative calculation 
results and chromatograms of multiple data. 
In the [Quant Browser] window of the [Browser] program, you can check multiple data, 
and change the data processing parameters of the currently displayed method file to 
modify calibration curves and perform postrun batch on multiple data.

$$ �Refer to "Quant Browser" chapter in Operators Guide for details on the "Quant Browser" 
window.

Chapter

6
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6  Multiple Data Analysis

3	 Load the batch file.

2

1

Drag and drop this file to display the 
quantitative results data.

Continued on the following page
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4	Confirm the quantitative results.
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6  Multiple Data Analysis

LabSolutions

SUPPLEMENT

Modify Calibration Curves

1	Confirm peak integration parameters.
Confirm the peak integration parameters when peak detection is inappropriate.

1

Make sure that these 
values are appropriate.

2

Click here to perform 
postrun batch on all data.

ZOOM 
UP

3

Continued on the following page
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2	Confirm identification parameters.
Confirm the identification parameters and Compound Table when peaks are not identified correctly.

1
2

3

ZOOM 
UP

Make sure that these 
values are appropriate.

3	Confirm the Compound Table.

2
4

Make sure that these 
values are appropriate.

ZOOM 
UP

3
1
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6  Multiple Data Analysis

4	Confirm calibration points.

2

Confirm the calibration curve.
ZOOM 

UP

1

Make sure that the 
calibration point on the 
1st row is set to .

5	 Save the method file and data file.
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LabSolutions

SUPPLEMENT Export Quantitative Calculation Results
This section describes how to save quantitative calculation results as a text file.

1

4

2

3

5

Click here to save the "QuantResult.txt" 
file in the Sample folder.

Select [Output File], and 
enter "QuantitativeResult" 
as the file name.

Select [Items Displayed 
on the Screen].

Select [All IDs].

$$ �Refer to "Export the Quantitative Results" of the "Quant Browser" chapter in Operators Guide for details on 
exporting quantitative results.
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6  Multiple Data Analysis

LabSolutions

SUPPLEMENT Print the Quantitative Results Table
To print a browser report, select [Print] at [Print Table] on the [File] menu.

Select [Edit Format] from 
[Print Table] on the [File] 
menu to edit the report 
format.

DD �
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1	Open the [DataManager] program.

1

2

2	 Select [Data] for [Files of type].

 

The Data Manager can be used to view information on methods, batches, and report format 
files.
To view such information, clicking on [Show Method/Batch/Report Format in Database] in the 
[Tools] menu allows you to select method, batch, or report for [Files of type].

DD �

Data Management
The [DataManager] program in LabSolutions provides a convenient way to filter and 
view the files used by LabSolutions, which include data files, method files, batch files, 
and report format files, by specifying filtering conditions, such as the instrument name.

$$ �Refer to the System Users Guide for details on the [DataManager] window.

Chapter

7
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7  Data Management

3	 Filter the data using the [Instrument Name] condition.

2

1

3

Enter "Instrument1" for [Instrument Name].

Continued on the following page
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4	Check the filtered data.

Check the filtered data file names.

5	Check the information of the selected data.

ZOOM 
UP

1

Click on "Tutorial_Std002.lcd".

Check the information 
contained in the data.
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7  Data Management

6	Display the PDF result file for the data file. 

Click on "Tutorial_Std002.lcd".

Double-click on "  Tutorial_Std002.pdf *".

1

2
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 PDF Result File

9/13/2010 1:11:31 PM Page 1 / 1

Sample_LC_EN - 0-1/0-18 - Tutorial_Std002.lcd

Analysis Report

Sample Name : Paraben Mixture
Sample ID : Standard 10ppm
Data Filename : Tutorial_Std002.lcd
Method Filename : Tutorial_Method.lcm
Batch Filename : Tutorial_Batch.lcb
Vial # : 1-1 Sample Type : Standard
Injection Volume : 10 uL Level : 1
Date Acquired : 5/12/2009 3:30:04 AM Acquired by : System Administrator
Date Processed : 9/13/2010 1:11:30 PM Processed by : System Administrator

<Chromatogram>

min
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0.0 2.5 5.0 7.5 10.0

0

25

50

75

100

Detector A 254nm
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0
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3

8.
27

6
<Peak Table>
Detector A 254nm
Peak#

1
2
3
4
5

Total

Ret. Time
1.650
3.050
3.929
5.513
8.276

Area
5207

582482
524475
526966
493798

2132927

Height
345

108360
81474
63012
41441

294631

Conc.
0.000
9.889
9.905
9.924
9.931

Unit

mg/L
mg/L
mg/L
mg/L

Mark Name

Methylparaben
Ethylparaben
Propylparaben
Butylparaben

<Sample Information>
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7  Data Management

LabSolutions

SUPPLEMENT Open the [Postrun Analysis] Program.
The procedure for opening the [Postrun Analysis] program from the Data Manager 
is described below.

Select "Tutorial_Std002.lcd", right-
click on the file name, and then click 
[Open with Related Application].

The [Postrun Analysis] 
program opens.
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1	 Stop instrument operation.
Stop pump solvent delivery and heating of the column oven.

2	 Set  to OFF.

3	 Select [Exit] when the oven has cooled down. 

ShutDown
Last of all, this chapter describes how to exit LabSolutions.

Chapter

8
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8  ShutDown

4	Click [Yes].

When there is a file that has not yet been saved, 
a window to confirm whether or not to save the 
file when exiting the [Realtime Analysis] program 
opens. 

DD �

5	 Exit LabSolutions.
If the [Postrun Analysis] program or [Browser] program is open, click [Exit] on the 
[File] menu of each program to exit the respective program.

6	 Shutdown Windows, and turn the PC and printer off. 

7	 Turn each instrument off.
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